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• This guide explains how to install the software programs and
briefly introduces their functions and operating procedures. For
more detailed explanations, see the Help menu for each
program.

• Please read the software license agreement in this guide before
using the software. By using the software, you agree to be
bound by the terms of the agreement.
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Do not connect the camera to the computer before the software is
installed.



Disclaimer
• While every effort has been made to ensure that the information contained in this guide is

accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.
• Adobe is a trademark of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer

Inc., registered in the United States and other countries.
• Microsoft, Windows, Windows media and Windows logo are either registered trademarks or

trademarks of Microsoft Corporation in the United States and /or other countries.
• Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape

Communications Corporation in the United States and other countries. Netscape
Communicator is a trademark of Netscape Communications Corporation.

• Other names and products not mentioned above may be registered trademarks or trademarks
of their respective companies.

Copyright © 2002 Canon Inc. All rights reserved.

SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and
correct use of the products and to prevent injuries or damage to yourself, other
persons and property. Please read and ensure that you understand them before
proceeding to other sections of the guide.

Warnings This symbol indicates topics that could lead to death or serious
injury if ignored or handled incorrectly.

Warning
• Do not play the supplied CD-ROM(s) in any CD player that does not support data

CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could
damage the speakers. It is also possible to suffer from hearing loss from listening
with headphones to the loud sounds of a CD-ROM played on a music CD player.
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READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS
BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE
SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE USER
MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN THE SOFTWARE
TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE:  Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single
computer.  You may physically transfer the SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time.  You shall not install or use the SOFTWARE on a
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the
SOFTWARE is accessible to more than one CPU or to more than one user.

With respect to the sound and image data (“Data”) contained in the Software, which are to be
downloaded to the applicable Canon digital camera product, Canon grants you a personal, non-exclusive
license to use the Data on a single Canon digital camera product only.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original
for back-up purposes.  Any other copying of the SOFTWARE is a violation of this Agreement.  You must
reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES:  Neither Canon, nor its subsidiaries, dealers or distributors will be responsible
for providing maintenance or support for use of the SOFTWARE.  No updates, fixes or support will be
made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose, maintain and
match the hardware and software components of your computer system.  Thus Canon does not
guarantee uninterrupted service or correction of errors or that the functions or performance of the
SOFTWARE will meet your requirements.  THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND
WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted
only against defective material under normal use for a period of ninety (90) days after purchase from an
authorized Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM
shall be replacement of the same without charge when returned by you at your expense to your point of
purchase and proven to be defective upon inspection.  The Replacement CD-ROM will be warranted for
the remainder of the original ninety (90) day warranty period of the defective CD-ROM.  The limited
warranty does not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of
the SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES,
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE
FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT,
CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR
INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE
THEREOF.
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NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL
HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A
THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY
INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE
ON THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY
TO YOU.

5. TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration
of all copyright interests in the SOFTWARE unless earlier terminated.  You may terminate this Agreement
by destroying the SOFTWARE.  This Agreement will also terminate without notice to you if you fail to
comply with any of the terms of this Agreement and you must then promptly return the SOFTWARE.  In
addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting
of “commercial computer software” and “commercial computer software documentation,” as such
terms are used in 48 C.F.R. 12.212 (Sept 1995).  Consistent with 48 C.F.R. 12.212 and 48 C.F.R.
227.7202-1 through 227.72024 (June 1995), all U.S. Government End Users shall acquire the SOFTWARE
with only those rights set forth herein.  Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-
ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS:  You agree to comply with all export laws and restrictions and regulations of
the country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of
any such laws and restrictions and regulations, or without all necessary approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal
of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that
court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

9. CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the Software in the
United States of America shall be governed and construed in all respects in accordance with the laws and
regulations of the State of New York, without reference to choice of law principles.  The terms of this
Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the
province of Ontario.

10. OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors.  Your use of the
SOFTWARE is subject to the laws of the United States, and Canada, and other applicable copyright and
trademark laws, and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated
corporations and third party licensors under such laws.  You only own the CD-ROM media in which the
Software is stored.  Except as expressly provided herein, no license or right, express or implied, is hereby
conveyed or granted by Canon to you for any intellectual property of Canon.  Nothing contained in
Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual
material that you save in connection with the Software.

You may not modify, remove or delete any or all copyright notices (i) which are contained in the Software,
including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of a back-up
copy made pursuant to Section 2 above.

11. ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ
THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE
STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER
HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND
ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF.  NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A
DULY AUTHORIZED OFFICER OF CANON.



Read this First
(Windows ® / Macintosh)

A Guide to the Manuals ..................................................... 2
What Can Be Accomplished with the Software ................ 6

Canon Digital Camera Solution Disk ..................................... 6
System Requirements ...................................................... 11

Windows .......................................................................... 11
Macintosh ......................................................................... 12

Connecting the Camera to a Computer ........................... 13
Selecting a Downloading Method ....................................... 13
Connecting to a USB Port .................................................. 14
Connecting to a CF Card Reader or PC Card Reader ............ 15



2

A Guide to the Manuals

The following manuals are supplied with the software products. Please read the
respective manual according to the guidelines below.

Software Starter Guide (This Guide)

This manual explains how to install the software and provides a
simple description of how you can download images recorded with
the camera onto your computer.

Read this Manual for the Following

• When you wish to install/uninstall the software
• When you wish to install/uninstall the USB Driver
• When you wish to download recorded images to your computer
• When you wish to learn the features of ZoomBrowser EX

(Windows) and ImageBrowser (Macintosh)

ZoomBrowser EX Software User Guide (Windows)
ImageBrowser Software User Guide (Macintosh)

The manuals in PDF format provide a relatively detailed description of
the operating procedures for the ZoomBrowser EX program for
Windows and the ImageBrowser program for Macintosh.

Read this Manual for the Following

• When you wish to organize and search for images
• When you wish to edit or add special effects to images
• When you wish to print images
• When you wish to stitch images together into a panoramic image
• When you wish to edit a camera slide show
• When you wish to send an image as an email attachment
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Card Photo Printer CP-10
Printer Driver User Guide (Windows/Macintosh)

This manual in PDF format explains how to install the printer driver
for Card Photo Printer CP-10 (sold separately) onto your computer
and connect the printer to the computer for printing.

Read this Manual for the Following

• When you wish to install/uninstall the printer driver (required to
use the CP-10)

• When you wish to install/uninstall the USB driver
• When you wish images saved onto the computer to be printed

with the CP-10
• When you wish to print original photo cards
• When you wish to print on labels (8-label sheets)

Each software program is also supplied with an onscreen Help
menu that explains detailed operating procedures. Please use
the Help menu in conjunction with the other manuals.
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How to View the Software User Guides for ZoomBrowser EX
and ImageBrowser

• Adobe Acrobat Reader must be installed on your computer to read the
ZoomBrowser EX Software User Guide (Windows) or ImageBrowser
Software User Guide (Macintosh), which are PDF files. If it is not, please
read the explanation for installation instructions at the bottom of next
page.

The ZoomBrowser EX Software User Guide (Windows) and ImageBrowser Software
User Guide (Macintosh) are contained as PDF files on the Canon Digital Camera
Solution Disk, a CD-ROM.

Windows
1.Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

The installer panel will display.
2. In the installer panel, click [Using the Software] and [ZoomBrowser EX].

The guide will display.
• If the installer panel does not display automatically, open the [Readme] and [English]

folders on the CD-ROM and double-click the [ZOOMBROWSER EX GUIDE.PDF] file.

Macintosh
1.Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
2.Double-click the CD-ROM icon followed by the [Canon Digital Camera Installer]

icon.
The installer panel will display.

3. In the installer panel, click [Using the Software] and [ImageBrowser].
The guide will display.

• You can also display it by opening the [Readme] and [English] folders on the CD-
ROM and double-clicking [IB_guide.pdf].
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How to View the Card Photo Printer CP-10 Printer Driver
User Guide

• Adobe Acrobat Reader must be installed to view the Printer Driver
User Guide (Windows/Macintosh) for Card Photo Printer CP-10. If it is
not installed on your computer, install it using the procedures at the
bottom of the page.

The Card Photo Printer CP-10  Printer Driver User Guide (Windows/Macintosh) is
contained on the Canon Digital Camera Solution Disk.

Windows
1.Place the Canon Digital Camera Solution Disk in your computer’s CD-ROM drive.

The installer panel will display.
2. In the installer panel, click [Using the Software] and [CP-10 Printer Driver].

The Card Photo Printer CP-10 Printer Driver User Guide (Windows/Macintosh) will
display.

• If the installer panel does not display automatically, open the [Readme] and
[English] folders on the CD-ROM and double-click the [CP-10.pdf] file.

Macintosh
1.Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
2.Double-click the [Canon Digital Camera Installer] icon in the CD-ROM window.

The installer panel will display.
3. In the installer panel, click [Using the Software] and [CP-10 Printer Driver].

The Card Photo Printer CP-10 Printer Driver User Guide (Windows/Macintosh) will
display.

• You can also display it by opening the [Readme] and [English] folders on the CD-
ROM and double-clicking the [CP-10.pdf] file.

How to Install Adobe Acrobat Reader
• Windows
1. Place the Canon Digital Camera Solution Disk in the computer’s CD-ROM drive.
2. Open the [Readme], [English] and [Acrobat] folders.
3. Double-click the [Ar405eng.exe] file to start the installer.
Follow the onscreen instructions to install Adobe Acrobat Reader.

• Macintosh
1. Place the Canon Digital Camera Solution Disk in the computer’s CD-ROM drive.
2. Open the [Readme], [English] and [Acrobat] folders.
3. Double-click the [Reader Installer] file to start the installer.
Follow the onscreen instructions to install Adobe Acrobat Reader.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained on the
CD-ROMs.
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Canon Digital Camera Solution Disk

• Downloading Camera Images to Your Computer
ZoomBrowser EX (Windows)/ImageBrowser (Macintosh)
You can start either of these programs* and display the camera images automatically
simply by connecting the digital camera to the computer’s USB port. Download the
camera’s still images or movies by selecting the thumbnails (tiny images) shown on
the computer display.
* For Windows systems, the ZoomBrowser EX auto start function is only supported for

Windows 98/Windows 2000/Windows XP. It is not supported for Windows Me.

TWAIN Driver (Windows)
This driver for Windows 98 and Windows 2000 loads camera images into TWAIN-
compliant programs, such as Adobe Photoshop.

WIA Driver (Windows)
This driver for Windows Me and Windows XP starts the Scanners and Cameras
Wizard to automatically download camera images to the computer. It also allows you
to copy camera images using standard file copying procedures in Windows Explorer
(but it cannot upload computer files to the camera).
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Plug-In Module (Macintosh)
This plug-in module loads camera images into plug-in compliant programs such as
Adobe Photoshop on the computer.

USB Mounter (Macintosh)
This utility allows you to treat the camera like a computer drive or read-only CF card
reader, displaying the CF card contents on the computer and permitting files to be
downloaded as if they were being copied from a card reader.

• Categorizing and Organizing Large Volumes of Images
ZoomBrowser EX (Windows)/ImageBrowser (Macintosh)
These programs display downloaded images in lists and allow you to sort and
organize them by content. They allow you to search and organize images as if they
were spread out on your desktop.

• Searching and Organizing Images Chronologically
ZoomBrowser EX (Windows)/ImageBrowser (Macintosh)
These programs can display images in order according to the creation date. As the
images display in a simulated time tunnel, you can zoom the tunnel forward and
backward in time as if you were moving through time.
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• Creating Mail Attachments from Images
ZoomBrowser EX (Windows)/ImageBrowser (Macintosh)
These programs can start your email program* and send images as file attachments
to it. Since the file size and compression rate can be controlled, you can reduce large
image files to sizes small enough for easy transmission.
* The automatic start of email programs is only supported by Windows and the email

programs must be enabled as MAPI clients.

• Laying Out and Printing Images
PhotoRecord (Windows)/ImageBrowser (Macintosh)
These programs permit you to add backgrounds and borders (Windows only), as well
as titles and comments, and print out the images. You can enjoy preparing prints of
your images appearing as if they were pasted into a photo album. Naturally, you can
also use them to make artistic single-image layouts.
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• Programs for Printing Indexes
PhotoRecord (Windows)/ImageBrowser (Macintosh)
These programs can output an index of the computer or camera’s image thumbnails
(tiny versions) to a printer.

• Programs for Printing with Card Photo Printer CP-10
PhotoRecord (Windows)/ImageBrowser (Macintosh)
These programs can output your original photo cards with added text or design, or
labels (8-label sheets) to Card Photo Printer CP-10 (sold separately) when connected
to the computer by interface cable PIF-100 (sold separately).

• Merging Panoramic Images
PhotoStitch
This program takes images shot over several frames in the camera’s Stitch Assist
mode, automatically arranges them in order and stitches them together in one simple
procedure. You can shoot and stitch 360º scenes together and save them in the
QuickTime VR format to make them appear to surround you as you view them.
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• Computer-Controlled Camera Shooting
RemoteCapture
This program allows your camera’s shutter to be controlled by the computer when
the two are connected. The recorded images are loaded directly into the computer.
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System Requirements

Please install the software on a computer meeting the following minimum requirements.
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Windows
Computer Model IBM PC/AT compatible

OS Windows 98 (First or Second Edition)
Windows Millennium Edition (Windows Me)
Windows 2000
Windows XP

CPU Windows 98/Me/2000: Pentium 150 MHz or better
Windows XP: Pentium 300 MHz or better

RAM Windows 98: 32 MB or more
Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface USB: only preinstalled Windows 98/Windows Me/Windows 2000/
Windows XP systems with built-in USB ports

Free Hard Disk Space • Canon Utilities
   - ZoomBrowser EX: 120 MB or more
       (Including the PhotoRecord printing program)
   - PhotoStitch: 40 MB or more
   - RemoteCapture: 20 MB or more
• Canon Camera TWAIN Driver: 25 MB or more
• Canon Camera WIA Driver: 25 MB or more
• Canon CP-10 Printer Driver: 1 MB or more

(space required for installation)

Display 800 x 600 pixels / 256 colors (8 bit) or better
1,024 x 768 pixels / High Color (16 bit) or better is recommended

• A CD-ROM drive is required to install the software.
• QuickTime 3.0 or a higher version is required to play the camera’s

movies or save images merged with PhotoStitch in the QuickTime VR
format. QuickTime 5.0 is included on the Canon Digital Camera
Solution Disk.

• A sound card is required to play movie audio tracks.
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Macintosh:
Computer Model Power Macintosh, PowerBook, iMac, iBook

OS Mac OS 8.6-9.2, Mac OS X (Version 10.1)

CPU PowerPC

RAM Mac OS 8.6-9.2: 20 MB or more of application memory
Mac OS X (Version 10.1): 128 MB or more of RAM

Interface USB: only systems equipped with genuine Apple-brand built- in
USB interfaces

Free Hard Disk Space • Canon Utilities
   - ImageBrowser: 20 MB or more
   - PhotoStitch: 30 MB or more
   - RemoteCapture: 15 MB or more
• USB Mounter: 5 MB or more
• Canon Camera Plug-In Module: 15 MB or more
• Canon CP-10 Printer Driver: 3.8 MB or more

(space required for installation)

Display 800 x 600 pixels / 256 colors or better
1,024 x 768 pixels / 32,000 colors or better is recommended

• Only ImageBrowser and PhotoStitch are compatible with Mac OS X
(Version 10.1). However, they are not compatible with disks formatted
with the Unix File System (UFS).

• USB Mounter is compatible with Mac OS 9.0-9.2.
• A CD-ROM drive is required to install the software.
• QuickTime 5.0 is included on the Canon Digital Camera Solution Disk.
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Downloading Method Page Reference

P. 14

P. 15

Downloading from the camera via the USB interface

Downloading from a card reader

Connecting the Camera to a Computer

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Selecting a Downloading Method
The downloading method you choose will depend upon the operating system (OS)
on your computer. Read the appropriate page referenced below after checking your
computer system.

Windows Users
• Do not connect the camera to a Windows computer at this point. The USB

Driver must be installed before the camera is connected to the computer
via the USB interface. The USB Driver can be installed very easily, so please
wait until the driver is installed before connecting the camera.

• You should use a household power source to power the camera when it
is connected to the computer.
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Connecting to a USB Port
Connection Precautions

• Connect the camera directly to a USB port on the computer; not through a hub.
The connection may not operate correctly through a hub.

• The connection may not operate correctly if you are using other USB devices,
excluding USB mice or keyboards, at the same time. If this occurs, disconnect the
other devices from the computer and try reconnecting the camera.

• Do not connect two or more cameras to the same computer via the USB
interface. The connections may not operate correctly.

• Never allow the computer to go into standby (sleep) mode while a
camera is connected via the USB interface. If it does happen, never
disconnect the USB cable. Try to awaken the computer with the camera
in the connected state. Some computers will not awaken properly if you
disconnect the camera while they are in standby mode. Please refer to
your computer manual for instructions regarding its standby mode.

1. Install the software (first-time connection only)

• Windows users see p. 18.
• Macintosh users see p. 58

2. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal.

• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB ports.

3. Prepare the camera for communication with the computer.

• Press the camera’s  button and set it to Replay mode.

Please refer to the Camera User Guide bundled with your camera for instruction
on how to attach/detach the cable.
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Connecting to a CF Card Reader or PC Card Reader
If you have a CF card reader, you can download images directly to a computer by
placing the camera’s CF card in a reader connected to the computer. If your computer
has a PC card slot or a PC card reader connected, remove the CF card from the
camera and insert it into a PC card adapter (PCMCIA adapter) before placing it into
the card slot on the computer or reader.

1. Remove the CF card from the camera and, if required, insert it into a PC
card adapter.

2. Place the card in the CF card reader or the loaded adapter into the card
slot on the computer or PC card reader.

• Since the requirement for the power to be on or off varies widely between
computers and card readers, please refer to your computer or card reader
manual before attempting this step.

Insert the card or loaded adapter

Insert the card into the adapter
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CF Card Folder Structure and File Names
The images on a CF card are placed in subfolders named [xxxCANON], where the
“xxx” represents a number from 100 to 998, within the [DCIM] folder.

* Files with the THM extension are the thumbnail image files for the camera’s index
replay mode.

** Each successive file shot in Stitch Assist mode is assigned a letter starting from
“A,” which is inserted as the third digit in the name. I.E. [STA_0001.JPG],
[STB_0002.JPG], [STC_0003.JPG] ...

• The “xxxx” in file names represent four-digit numbers.
• All folders except the “xxxCANON” folders contain image settings files. Do not

open or delete them.

IMG_xxxx.JPG (JPEG format images)
STx_xxxx.JPG** (Stitch Assist mode images)
MVI_xxxx.AVI (Movies)
MVI_xxxx.THM*

DCIM xxxCANON

CANONMSC

The folder that holds the settings files for images in
the DCIM folder.

MISC

The folder created when DPOF settings are set.
It holds the DPOF settings files.
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Installing/Uninstalling the Software

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Installing from the Canon Digital Camera Solution Disk
Installation Precautions

• Before you attach the camera to the computer with the USB cable for the first
time, you must install the appropriate driver software from the Canon Digital
Camera Solution Disk listed below onto the computer.

Windows 98 / Windows 2000: TWAIN Driver
Windows Me /Windows XP: WIA Driver

• If you are using Windows Me or Windows XP, there are several limitations to the
use of the WIA Driver. Before you install it, please read WIA Driver Installation
Precautions (p. 21).

• Users of Windows 2000 and Windows XP Professional must first log in as
an Administrator (computer system administrator) to install programs.

1. Close any programs that are running.

2. Set the Canon Digital Camera Solution Disk in the computer’s CD-ROM drive.

• The installer panel will display automatically.
• If the installer panel does not appear automatically, use the following

procedures to display it.

1. Double-click the [My Computer] icon on the desktop to open it and
double-click the CD-ROM icon.

2. Double-click the [Setup] icon.

3. Click [Software Installation].

Installer Panel



19

W
in

do
w

s

4. Follow the onscreen instructions to proceed with the installation.

5. When the Installer Panel displays again, after the installation is complete,
click [Exit].

• Remove the Canon Digital Camera Solution Disk once the installation is
complete so that the proper driver may be installed.

• Continue with the procedures on page 21 to install the driver software
to allow the camera to be connected to a computer via the USB
interface and download images.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Installing the Card Photo Printer CP-10 Printer Driver
The driver for Card Photo Printer CP-10 (sold separately) must be installed to print
from a CP-10 connected to the computer.* For installation instructions, please see
the Card Photo Printer CP-10 Printer User Guide contained on the Canon Digital
Camera Solution Disk as a PDF file (p. 5).
* Interface Cable PIF-100 (sold separately) is required to connect the Card Photo Printer

CP-10 to a computer.
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Uninstalling the Software/Driver

Uninstalling the Software
The following explanation uses the procedures for removing ZoomBrowser EX as an
example for removing other programs as well.

1. Click the Windows [Start] menu and select [Programs], [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser EX Uninstall].

The uninstall utility will start and remove ZoomBrowser EX.

• If you have uninstalled ZoomBrowser EX because of a corrupt database
file or other problem, please also delete the Database folder, which can
be found within the [C:\Program Files\Canon\ZoomBrowser EX] folder.

• PhotoRecord, PhotoStitch, RemoteCapture and other programs can be
removed with the same procedures.

• Please see page 27 for instructions for uninstalling the TWAIN Driver or
WIA Driver.

Uninstalling (Deleting) the Card Photo Printer CP-10 Printer Driver
For instructions to delete the printer driver, please see the Card Photo Printer CP-10
Printer User Guide contained on the Canon Digital Camera Solution Disk as a PDF file.
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Installing the TWAIN Driver / WIA Driver

• Be very careful to follow the steps below in order to install the driver
software.

1. Install one of the following drivers from the Canon Digital Camera
Solution Disk (p. 18).

Windows 98 / Windows 2000: TWAIN Driver
Windows Me / WIndows XP: WIA Driver

- Copy the required files to your computer.
2. Connect the camera to the computer with the USB cable.

- Complete the steps required to install the driver and then close the installer.
• The installation procedures may vary between Windows versions (pp.

22-24).

WIA Driver Installation Precautions
• You can install the WIA Driver if you are using Windows Me or Windows XP. In

addition, you should read the “WIA Driver Limitations” below before installing
the driver.

WIA Driver Limitations
• When you have set the WIA Driver to start a particular application program when

you connect the camera, the program may cause an error message similar to the
following to appear: “TWAIN data source not found. Reinstall the scanner
software.” If this happens, select [WIA-camera model] in the application program
as the TWAIN device. Your camera model name will appear in place of the
“camera model” in the brackets above.

• Windows Me users cannot use ZoomBrowser EX’s auto start function when the
WIA Driver is installed.

• TWAIN Driver is the driver software for USB connections to Windows 98
and Windows 2000 only. It is the software required to load images into
TWAIN-compliant application programs, such as Adobe Photoshop. Since
it is not a stand-alone program, you must always use it by starting it from
within a TWAIN-compliant program.

• WIA Driver is the driver software for USB connections to Windows Me
and Windows XP only. When you connect the camera to the computer
with a USB cable, the Scanners and Cameras Wizard will open
automatically to assist with downloading. This driver also allows you to
use Windows Explorer to display the camera’s thumbnail images on the
computer and download images with standard file copying procedures.
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Windows 98

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication with the
computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).

2. Do not insert the Canon Digital Camera Solution Disk and click [OK].

3. Click the [Browse] button.

The Open dialog will display.

4. Select the following folders in the order [Program Files], [Canon],
[PowerShot A200 TWAIN] on the drive on which you installed the software.

Double-click the drive (usually the [C:\] drive) on which you installed the
software to display all of its folders and select the appropriate folder.

5. Click the [OK] button once you have selected the last folder.

• The window in Step 3 will reappear.

Double-click the following
folders in the order [Program
Files], [Canon] and [PowerShot
A200 TWAIN].
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6. Click the [OK] button.

• The TWAIN Driver will install itself automatically.
• The Event dialog will display when the installation is complete, allowing you to

select a program to start (p. 32).

Windows 2000/Windows Me

• Users of Windows 2000 must first log in as an Administrator to install
programs.

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication with the
computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The Add New Hardware Wizard will appear after a moment and automatically

install the TWAIN Driver or WIA Driver.
• If you are prompted to restart the computer, restart the computer according to

the onscreen messages.

• If you are using Windows 2000, the Event dialog will display when the installation is
complete, allowing you to select a program to start (p. 32)

• If you are using Windows Me, the Scanners and Cameras Wizard will start (p. 53).

Windows XP

• Users of Windows XP Professional must first log in as an Administrator
(computer system administrator) to install programs.

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication with the
computer.

• For USB interface connection instructions, see Connecting to a USB port (p. 14).
• The Found New Hardware Wizard will appear after a moment and automatically

install the WIA Driver.

Once the installation is complete, the ZoomBrowser start-up event dialog and the
Scanners and Cameras Wizard start-up event dialog will both display. Click [OK] in
the event dialog of the application you wish to start (ZoomBrowser EX or Scanners
and Cameras Wizard). The event will start.
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When you use Windows XP, please set your computer to automatically start an
event when the camera is connected to the computer. Be sure to set the computer
to start either ZoomBrowser EX or the Scanners and Cameras Wizard. If neither of
these is selected the computer will not operate properly.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Setting an Event to Start Automatically (Windows XP only)
You can set your computer to automatically start an event when the camera is
connected to the computer via the USB cable. Please set the computer to start either
ZoomBrowser EX or the Scanners and Cameras Wizard. If neither of these is selected
the computer will not operate properly.

1. Connect the camera to the computer.

• If the Event Dialog appears, click [Cancel] to close it.

2. From the [start] menu, click [Control Panel] and click the [Printers and
Other Hardware] icon.

3. Click the [Scanners and Cameras] icon.
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When you want to start ZoomBrowser EX automatically

1. Set [Select an event] to [Default]. Set the [Actions] section to [Take no
action].

2. Now repeat the above, however this time set [Select an event] to
[(camera name) Connected], and in the [Actions] section, set [Start this
program] to [Canon ZoomBrowser EX].

When you want to start the Scanners and Cameras Wizard automatically

1. Set [Select an event] to [Default]. In the [Actions] section, set [Start this
program] to [Microsoft Scanners and Cameras Wizard].

2. Now repeat the above, however this time set the [Select an event] to
[(camera name) Connected], and set the [Actions] section to [Take no
action].

6. Click [OK].

Next time, either ZoomBrowser EX or the Scanners and Cameras Wizard
will start automatically.

The name of your
camera will be
displayed.

4. Select the camera icon and click the [View device properties] icon in
[Imaging Tasks].
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Troubleshooting the TWAIN Driver/WIA Driver Installation
First, Check the Following

1. Does your computer comply with these requirements?
Does the system have a built-in USB port and did it come with Windows 98 (First
or Second Edition), Windows Me, Windows 2000, or Windows XP preinstalled?
(The USB interface is not supported for systems not complying with the above
conditions.)

2. Is the camera correctly connected to the computer?
Please see Connecting the Camera to a Computer (p. 13).

3. Is the battery charge sufficient?
You should use a household power source to power the camera when it is
connected to a computer.

• If the Problem Lies in the Above
The Add New Hardware Wizard (in Windows 2000, the New Hardware Found
Wizard) may display. If that happens, click [Cancel] to close it. Then disconnect the
camera from the computer before reinstalling the USB Driver according to the
procedures in Installing the TWAIN Driver / WIA Driver (p. 21).

• If the Problem Is Not Mentioned Above
If the USB Driver is not correctly installed, it is possible that Windows is not
recognizing the USB Driver. Uninstall the USB Driver according to the instructions on
page 27 before reinstalling it according to the instructions in Installing the TWAIN
Driver / WIA Driver on page 21.
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Uninstalling the TWAIN Driver / WIA Driver

You can uninstall the TWAIN Driver (Windows 98 /Windows 2000) or the WIA Driver
(Windows Me / Windows XP) with the following procedures.

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal. Prepare the camera for communication with the
computer.
• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
•  With Windows 98 and Windows 2000, the event dialog will appear, allowing

you to select an application program to start. With Windows Me, the Scanners
and Cameras Wizard will appear. With Windows XP, ZoomBrowser EX will start
or the Scanners and Cameras Wizard will appear.

2. Click the [Cancel] button.
• If ZoomBrowser is started, close it.

3. Click the Windows [Start] menu and select [Settings] and [Control Panel].
• If you are using Windows XP, from the [start] menu, click [Control Panel] and

click the [Printers and Other Hardware] icon.

4. Double-click the [Scanners and Cameras] icon or folder.
• If you cannot find the [Scanners and Cameras] icon or folder, use the

procedures on page 28 to uninstall the driver.

5. Delete the camera model name from the [Scanners and Cameras
Properties] list in Windows 98 or Windows 2000, or the camera icon from
the [Scanners and Cameras] folder in Windows Me or Windows XP.

 Windows 98 or Windows 2000

 Select the name of your camera model and click the [Remove] button.

Windows Me or Windows XP

Select the icon of your camera model, right-click the mouse button and
select [Delete].

Your camera model name will appear
here. If it does not display here, use the
procedures on page 28 to uninstall the
driver.
If a scanner driver has also been installed,
its name will also appear in the list.
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6. TWAIN Driver: Click the [Start] menu and select [Programs], [Canon Utilities],
[PowerShot A200 TWAIN Driver] and [TWAIN Driver Uninstall].
WIA Driver : Click the [Start] menu and select [Programs] or [All Programs],
[Canon Utilities], [PowerShot A200 WIA Driver] and [WIA Driver Uninstall].

The uninstall process will start.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Troubleshooting the TWAIN Driver/WIA Driver Uninstall
If you have problems uninstalling the driver, use the following procedures to remove it.

Use the procedures below for the following circumstances too.
• If you do not find the [Scanners and Cameras] icon or folder in the

[Control Panel] or [Printers and Other Hardware].
• If your camera model name does not appear in the [Scanners and

Cameras Properties] dialog or the camera icon does not appear in the
[Scanners and Cameras] folder.

• If you installed the USB Driver by connecting the camera to the
computer via the USB interface before you installed the other software
on the CD-ROMs.

Windows 98/Windows Me

1. Open the [System Properties] dialog and check the [Device Manager] tab.

1. In the [Control Panel], double-click the [System] icon.
2. Click the [Device Manager] tab.

2. If your camera model name appears under the [Other devices] and/or
[Imaging Devices] categories, use the following procedures to delete it.

1. Select the name of your camera model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
• Remove all copies of your camera model name that appear in the [Other devices]

or [Imaging Device] categories, or that appear more than once in one category.
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* This example shows Windows 98 screen shots.

4. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

5. In the [Inf] folder, double-click the [Other] folder to open it.

• The Inf folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you
delete the wrong file, you may be unable to restart Windows.

6. Find and delete the [Canon.IncCAP_A200] file.

• If the above file is not contained in the Other folder, you do not need to delete
anything.

3. Double-click the [My Computer] icon on the desktop followed by the [C:]
drive and the [Windows] and [Inf] folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.
1. For Windows 98, click the [View] menu and select [Folder Options]. For Windows

Me, click the [Tool] menu and select [Folder Options].
2. Click the [View] tab.
3. For Windows 98, set the [Hide files] section to [Show all files]. For Windows Me,

set the [Hidden files and folders] section to [Show hidden files and folders].
4. Click [OK] to close the dialog.
This will make the hidden files and folders visible.
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Windows 2000/Windows XP

• Users of Windows 2000 or Windows XP Professional must first log in as
an Administrator (computer system administrator) to uninstall the driver.

1. Open the [System Properties] dialog and check the [Device Manager].

1. For Windows 2000, in the [Control Panel], double-click the [System] icon.
For Windows XP, in the [Control Panel], click [Performance and Maintenance]
and click [System].

2. Click the [Hardware] tab and the [Device Manager...] button.

2. If your camera model name appears under the [Other devices] or [Imaging
Device] category, use the following procedures to delete it.

1. Select the name of your camera model, right-click the mouse button and select
[Delete].

2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
• Remove all copies of your camera model name that appear in the [Other devices]

or [Imaging Device] categories, or that appear more than once in one category.

3. Windows 2000: Double-click the [My Computer] icon on the desktop,
followed by the [C:] drive, and the [Winnt] and [Inf] folders.

Windows XP: From the [start] menu, double-click [My Computer], [C:],
[Windows] folder, and [Inf] folder in succession.
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If the [Inf] Folder Is Not Visible in the [Winnt] or [Windows] Folder
Use the following procedures to show all files and folders.
1. Open the [Winnt] or [Windows] folder.
2. Click the [Tools] menu and select [Folder Options...].
3. Click the [View] tab.
4. In the [Advanced settings] section, set the [Hidden files and folders] category to

the [Show hidden files and folders] option.
• If [Hide extensions for known file types] is selected, remove its check mark.

5. Click [OK] to close the dialog.
This will make the hidden files and folders visible.

4. Look for the file starting with [Oem*].

• A number such as “0” or “1” will appear in place of the asterisk (*) above. You
will also find another file called [Oem*.pnf], which will have the same number
as the [Oem*.inf] file. The two constitute one set (i.e. Oem0.inf and Oem0.pnf).
Please note that there may be many file sets starting with “Oem” so take care
to get the correct set.

5. Confirm that it is the correct [Oem*] file set for Canon digital cameras.

• Double-click the [Oem*.inf] file. The Windows Notepad program will start and
show the file contents. Click each [Oem*.inf] file until you find one that
contains “*** Canon Digital Camera USB Setup File ***” in its first line. When
you find the correct file, note down its name and close the Notepad window.

6. Delete the [Oem*] file set.

• Delete the [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the
correct files.

• The Inf folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you
delete the wrong file, you may be unable to restart Windows.
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Downloading Images to a Computer

This topic briefly explains how to use ZoomBrowser EX to perform a range of
operations from downloading the camera’s images to printing them.

• For a more detailed explanation of ZoomBrowser EX operations, please
see the ZoomBrowser EX Help menu or PDF manual, ZoomBrowser EX
Software User Guide (p. 4).

If the Continue Connection Confirmation Message Displays
• A message asking whether you wish to remain connected may appear when the

[Auto Power Down] function is set to [On], the camera and computer are
connected via the USB interface, and the connection is idle for a set period of time
(usually about 5 minutes). If the connection remains idle, the camera will
disconnect after approximately 1 minute.

Press the camera’s  button to reconnect. Please see the Camera User Guide for
more information.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Starting ZoomBrowser EX
USB Port Connection (Windows 98/Windows 2000/Windows XP)

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
Digital Terminal. Prepare the camera for communication with the computer.
• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• After a moment, the Event dialog will display and allow you to select an

application program to start.

Windows XP

ZoomBrowser EX will start immediately when it has been set to auto start
in the Setting an Event to Start Automatically (Windows XP only) section
(p. 24). Skip to step 3. If the Scanners and Cameras Wizard has been set
to auto start, the [Scanners and Cameras Wizard] dialog will display. Click
[Cancel] to close the dialog window. Follow steps 2 and 3 of the USB Port
Connection (Windows Me) section (p. 34).

Your camera model name
will appear here.
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2. Select [Canon ZoomBrowser EX] and click [OK].
• ZoomBrowser EX will start and open the ZoomBrowser EX Automation Wizard

dialog.

3. Confirm that [Display images in the Camera Window] is selected and click
the [Finish] button.

The Camera Window will open and display the camera images as
thumbnails (tiny versions) (p. 36).

• In the ZoomBrowser EX Automation Wizard dialog, you can select the
action that is carried out after ZoomBrowser EX starts. For more details,
see the PDF manual, ZoomBrowser EX Software User Guide (p. 4).

What to Do the Next Time ZoomBrowser EX is Started
• A dialog with the previously selected automated settings will display the next

time you start ZoomBrowser EX. To use these settings unchanged, click the
[Start] button. To do nothing, click [Cancel]. To change the settings, click
[Modify Settings].

• For more detailed instructions for changing settings, please see
the PDF manual, ZoomBrowser EX Software User Guide (p. 4).

Confirm that this
option is selected.

To change the settings, click [Modify
Settings] and select the desired action
in the ZoomBrowser EX Automation
Wizard dialog.
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Tree View Area

How to Have ZoomBrowser EX Start Automatically
(Windows 98/Windows 2000)

Use the following procedures to have ZoomBrowser EX start automatically without
showing the Event dialog.
1. With the camera connected to the computer via the USB interface, double-click

the [My Computer] icon on the desktop, followed by the [Control Panel] folder
and [Scanners and Cameras] icon or folder.

2. Select the name of your camera model.
3. Click the [Properties] button and the [Events] tab. A list of application programs

that can be automatically started will display.
4. Remove the check mark from all programs except ZoomBrowser EX and click [OK].
You have now set ZoomBrowser EX to start automatically the next time the camera
is connected.
If you wish to shut off the auto start, place a check mark in the [Disable device
events] or [Do nothing] options.

USB Port Connection (Windows Me)

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
Digital Terminal. Prepare the camera for communication with the computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The Scanners and Cameras Wizard will automatically open. Click the [Cancel]

button to close the Wizard.

2. Start ZoomBrowser EX.

• Double-click the [Canon ZoomBrowser EX] icon on the desktop. The first time
ZoomBrowser EX starts, a confirmation message will appear asking whether
you wish to register the [My Pictures] folder in ZoomBrowser EX. Click [Yes] if
you plan to use the My Pictures folder.

Canon ZoomBrowser EX Icon

3. Click [Canon Camera] in the Tree View area.

• Thumbnail versions of the camera images will display in the Camera window (p. 36).
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CF Card Reader / PC Card Reader Connection

1. Insert the CF card or loaded PC card adapter into the reader.

2. Start ZoomBrowser EX.

• Double-click the [Canon ZoomBrowser EX] icon on the desktop.
• If you are using Windows Me, a confirmation message will appear the first time

ZoomBrowser EX starts, asking whether you wish to register the [My Pictures]
folder in ZoomBrowser EX. Click [Yes] if you plan to use the [My Pictures] folder.

Canon ZoomBrowser EX Icon

3. Click the [Import Images] button and select [From CANON_DC X:\Dcim].

• Thumbnail versions of the camera images will display in the Camera window (p. 36).

If the message [The error “EX_Exception” ocurred in the program] appears,
the first time you start ZoomBrowser EX, please refer to page 89.
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The ZoomBrowser EX Camera Window
When a connection is opened to a CF card in a camera or a reader, the card’s images
display as thumbnails in the Camera window.

How to Check and Change Various Camera Settings
You can adjust the date, time and owner settings in the Camera Settings dialog
using the computer when the camera is connected. You can also check the battery
charge and remaining memory capacity.

1. In ZoomBrowser EX, click the [Setup Options] button and select [Camera
Settings] from the menu that displays. In the TWAIN Driver (p. 51), click the
[Camera Settings] button to open the Camera Settings dialog.

2. Check or change the settings.

Upload Button
Copy images from the computer onto the
CF card in the camera or reader.

An image of the connected camera or
CF card will display here.

Thumbnail

Setup Options Button
Set various camera
settings (see inset
below).

Delete Button
Delete selected
images.

Download Button
Load the selected images onto the computer (p. 37).

Your camera model name will appear here.

Input a camera owner name here (up to 31
characters).

Set the date and time here.

Click this button to synchronize the camera to
the computer’s date and time settings.

Check the battery charge here.

Click this to format the CF card in the camera.

Check the remaining memory capacity here.
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Downloading and Saving Images from the Camera

1. Create a new folder for saving images from the camera.

• In the Tree View area, right-click the [Image Library One] folder, select [New
Folder] from the pop-up menu and input a folder name.

2. Select the new folder in the Tree View area.

3. Select the images you wish to download from the Camera window and
click the [Download] button.

• Click on thumbnails to select them.

Downloaded images are saved to the computer disk and appear in the
Browser Display Area.

• The folder you created above normally appears within the [C:\Program
Files\Canon\ZoomBrowser EX\Image Library One] folder. The
downloaded image files are saved to the folder you created.

Tree View Area

The movie icon displays
on movie thumbnails.

Thumbnail



38

• You can also download images by dragging them from the Camera window and
dropping them on the Browser Display Area or Tree View area.

To disconnect the camera, click the close box  at the right of the Camera window
to close it.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Printing Images

1. Select the image(s) you wish to print.

• Movie images cannot be printed.

2. Click the [Print] button and select [Layout] from the displayed menu.

Tree View Area

Browser Display Area

The movie icon displays
on movie thumbnails

• The PhotoRecord printing utility will start and automatically display the selected
image(s) in a page layout.
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3. Select a print mode and click [Next].

• For the purposes of this example, please select [Artwork/Layout album].

• When you select the “Artwork/Layout album” option, you can resize or
reposition images freely for printing. The other print modes allow you to
do such things as tile the images for printing or arrange them for
printing on Canon perforated paper. See the ZoomBrowser EX Software
User Guide (p. 4), a PDF file, for a detailed explanation of the print
modes.

4. In the next dialog, set the paper size and other settings and click [Next].

5. In the last dialog, set the fine settings and click [Finish].

• The PhotoRecord window will display.

6. If you wish to change the layout, set the printing settings in the
PhotoRecord window.

7. Click the PhotoRecord [Print] button.

• The Print dialog will display.

8. Click [OK] to start printing.

• When you click the [Print] button and select [Index] from the displayed
menu, the Print Index dialog will display. Set the desired thumbnail size
and paper size, then click [Print] to start printing the index.
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Select whether
images are laid
out automatically,
manually or as an
index.

Set the printing
mode or paper
size.

You can freely
input page titles,
image titles, or
text.

You can drag
images to change
the layout.

Slide this left to
shrink the image
size and right to
increase it.

Stop importing
images.

Switch between
control panel
sizes with this.

Display Help.

Display the Print Dialog.

Undo or restore the previous
action.

Change the page background
or borders.

Import images.

Select a layout
pattern for each
page. Click the
arrow  to
display a pop-up
menu.

• PhotoRecord Window
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Scroll Mode
Use this mode to just display the
images within one folder. When there
are more images than can fit in the
Browser Display Area, scroll bars
appear on the right of the Browser
Display Area. The sub-folders only
appear as folder icons in this mode.

ZoomBrowser EX Features

This topic introduces additional, convenient ZoomBrowser EX features.

• For a more detailed explanation, please see the ZoomBrowser EX Help
menu or PDF manual, ZoomBrowser EX Software User Guide (p. 4).

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Using the ZoomBrowser EX Buttons
The bottom of the ZoomBrowser EX window contains the buttons that control various
functions. This topic describes four of those buttons that are particularly convenient.

Switching the Display Mode
You can change between the Zoom and Scroll modes to suit your purposes when
images are displayed in the Browser Display Area.

Zoom Mode
When you create a folder within a
folder, use this mode to display all the
images inside the sub-folder too.

The images inside the sub-folders also display.

Scroll Bar

The images inside the sub-folders do not display.

Zoom Mode Button
Switches to and from the zoom mode.

Scroll Mode Button
Switches to and from
the scroll mode.

Refresh Button
Updates the folder contents.

Register Image Folder Button
Registers the selected folder as an Image Folder.
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Registering a Folder as an Image Folder
Folders shown in the Tree View area with a  symbol are called Image Folders.
ZoomBrowser EX only manages the images contained in these folders and the
subfolders nestled within them.

1. Click the [Register Image Folder] button.

The Register Image Folder dialog will display.

2. Select the folder you wish to register and click the [OK] button.

• The folder will be registered as an Image Folder.

Refreshing a Folder
Only image files that are added, copied or edited using ZoomBrowser EX will display
correctly in a folder that is part of a ZoomBrowser EX image folder. If you move or
copy image folders with the Windows Explorer program or edit images with another
application, the information contained in ZoomBrowser EX will not be up-to-date. To
update a folder, select it and click the [Refresh] button. This will refresh the images in
the selected folder and any subfolders within it.

The folder is registered as an Image Folder.
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Replaying Movies
When you double-click an image with a movie icon in the Browser Display Area,
QuickTime Player will start and replay the movie.

• If QuickTime 3.0 or a later version is not already installed, install the
QuickTime 5.0 program from the Canon Digital Camera Solution Disk.
Place the disk in the CD-ROM drive and click [QuickTime 5.0 Installation]
in the installer panel (p. 18).

1. Double-click an image with a movie icon.

• QuickTime Player will start.

2. Click the play button in QuickTime Player.

• The movie will replay.

• Do not double-click a movie file (.AVI extension) in the Windows
Explorer to play it. That will start Windows® Media PlayerTM, which may
not support this file type. To replay movies, start QuickTime Player first
and open the file from within the program.

Play Button
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Merging Panoramic Images with PhotoStitch

To Merge Images Registered in ZoomBrowser EX
You can merge a series of overlapping images into a single, seamless panorama.

1. Select the images in the Browser Display Area, click the [Edit] menu and
select [PhotoStitch] to start the program.

2. Follow the instructions in the guidance window to merge the images.

• Please refer to the PhotoStitch Help menu for more details.
• Images shot in Stitch Assist mode with a wide converter, teleconverter or close-

up lens cannot be merged accurately.

Follow the instructions
to merge the images.

Stitch Assist mode images have a green
stitch mark. Click the stitch mark to start
PhotoStitch and merge the image series.

Images Shot in Stitch Assist Mode
PhotoStitch automatically arranges images shot with the camera’s Stitch Assist mode
in their correct order and orientation, making it easy to merge them. Stitch Assist
mode images appear in the Camera window as shown below.

Please see the Camera User Guide to learn how to shoot in Stitch Assist mode.
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Shooting with RemoteCapture
RemoteCapture will start if you click the [Edit] menu in ZoomBrowser EX and select
[RemoteCapture] when the camera is connected to the computer via a USB
interface. RemoteCapture lets you control the camera’s shutter remotely from the
computer to shoot still images.

• You can also save images directly to the computer by pressing the
camera’s shutter button. Other buttons and switches on the camera,
including the zoom, will not operate with a transmission in progress.

• You may notice that the interval between the shutter release and
activation is slightly longer when RemoteCapture is used to shoot than
when the camera is used in the normal fashion.

• Images shot with RemoteCapture are automatically saved to the folder
selected in ZoomBrowser EX.

• Save-RemoteCapture Window

View Button
Select an image in the Thumbnail View
and click here to display it in the Image
Display Area.

Delete Button
Select an image in the Thumbnail View
and click here to delete it. Since it is
deleted from the computer too, ensure
that you have the correct image.

Histogram
Check the distribution of brightness
data here.

Image Information
Check the image settings here.

Comments
Add a comment about the image here.

Thumbnail View
Displays thumbnails of all the images
shot after RemoteCapture is started.

Connect/Disconnect Button
Click here to open a connection to the
camera and display the RemoteCapture
Shooting window. It will change to the
Disconnect button while a connection is
open. Click it to close the connection.

Image Display Area
Displays the image selected in the Thumbnail View.
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• Shooting-RemoteCapture Window

Slide this to zoom the
camera in or out.

Test Preview
A Preview of the test shot
displays.

Set the basic camera
settings here.

Release Button
Click here to release the
camera’s shutter and
record the image.
Recorded images are
automatically saved to the
computer.

Test Release Button
Takes a test shot.Test
shots are not saved to
the computer.

Recordable Image Counter
Displays the number of images that will fit
onto the computer or Memory card in the
camera.

Click here to select
how images are
rotated when saved
to the computer.

Click here to change more
detailed camera settings.
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Shooting

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
DIGITAL terminal. Prepare the camera for communication with the computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• Open the camera lens cover after the connection is established.
• Windows 98/Windows 2000: the event dialog will appear, allowing you to

select an application program to start.
• Windows Me: the Scanners and Cameras Wizard will appear. Click the [Cancel]

button and double-click the [Canon ZoomBrowser EX] icon on the desktop to
start ZoomBrowser EX. From its [Edit] menu, select [RemoteCapture]. The
Shooting - RemoteCapture window will display. Proceed to Step 6.

• Windows XP: ZoomBrowser EX will start immediately when it has been set to
auto start in the Setting an Event to Start Automatically (Windows XP only)
section (p. 24). In this case, proceed to step 3 below. If the Scanners and
Cameras Wizard has been set to auto start, the [Scanners and Cameras Wizard]
dialog will display. Click the [Cancel] button and double-click the [Canon
ZoomBrowser EX] icon on the desktop to start ZoomBrowser EX. After
ZoomBrowser EX starts, click the [Edit] menu and select [RemoteCapture].
When the Shooting-RemoteCapture window opens, proceed to Step 6 below.

2. Select [Canon ZoomBrowser EX] and click [OK].
• ZoomBrowser EX will start and open the ZoomBrowser EX Automation Wizard.

3. Click the [Modify Settings] button.
• The ZoomBrowser EX Automation Wizard dialog will display.

4. Select [Launch RemoteCapture] and click the [Finish] button.
• RemoteCapture will start and display the “Connect to Camera?” dialog.

• If ZoomBrowser EX is already running, click the [Edit] menu and select
[RemoteCapture] to start RemoteCapture.

5. Click [Connect].
• Shooting-RemoteCapture window will display.

6. Set the Size/Quality, Flash, White Balance and Exposure Compensation
settings.
• If you turn the camera on either side to shoot, you can rotate the recorded

image 90º either way when it is saved by selecting [90 degrees left] or [90
degrees right] in the Rotation section. To change where the image is saved, see
Changing the Save Location and Other Preferences (p. 49).



48

7. If you click the [Test Release] button, you can check the image composition in
the Test Preview Area of the Shooting-RemoteCapture window.
• You can change the focal length with the Zoom slider.
• Click the [Detail setting] button to change more detailed camera settings.

8. Click the [Release] button.
• The image will record and be automatically saved to the computer. You can also

release the shutter by pressing the camera’s shutter button directly or pressing
the space bar on the computer keyboard.

Interval Timer Shooting
You can shoot a specified number of frames at set intervals.

1. In the Shooting-RemoteCapture window, click the [Shooting] menu and
select [Interval Timer Shooting].

• The Interval Timer Shooting dialog will display.

2. Set the number of frames and the interval value and click [OK].

• RemoteCapture will start Interval Timer shooting, capturing the specified
number of frames at the specified interval. You can specify an interval from 5
seconds to 60 minutes. You can capture up to the number of recordable frames
displayed in the RemoteCapture Shooting window (2 to 9999 frames).

Timer Shooting
You can use the timer feature to shoot after a specified number of seconds.

1. In the Shooting-RemoteCapture window, click the [Shooting] menu and
select [Timer Shooting].

• The Timer Shooting dialog will display.

2. Set the delay in seconds and click [Start].

• RemoteCapture will start timer shooting, recording an image after the specified
delay. You can specify a delay from 2 to 30 seconds.

Precautions for Shooting with RemoteCapture
• If your computer is set to go into standby mode, there is no guarantee that

RemoteCapture will continue to function after the computer enters standby mode.
Always turn off the standby function before you start shooting with
RemoteCapture.

• Please note that the camera will not be able to shoot at the specified interval if it is
shorter than the time required to transmit the data and save it to the computer.
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Changing the Save Location and Other Preferences
You can change where and how image files are saved.

1. In the save RemoteCapture window, click the [File] menu and select
[Preferences].

• The Preferences dialog will display.

2. Select the way images are saved and the folder to which they are saved
and click [OK].

• Preferences Dialog

Click an option to determine whether images are
saved to the camera’s CF card as well as the
computer. If you select [Computer only], you can
do without a CF card in the camera or continue
to record images after the CF card is full.

Input a root name for the image files here. If you
input “Capture”, for example, the first image will
be named [Capture_00001.jpg] and successive
images will automatically be assigned a name
that is one number higher than the last.

Select a folder where images will be saved.

Select the drive on the computer where images
will be saved.

Printing an Index of the Thumbnail Images
If you select images in the Thumbnail View area of Save-RemoteCapture window,
you can print them in an index like a contact sheet.
1. Select the images, click the [File] menu and select [Print Index].
The file name and shooting date are printed along with each image in the index,
providing a convenient record and means of checking your images.
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Loading Images into TWAIN-Compliant Programs

This topic explains how to load images into TWAIN-compliant application programs,
such as Adobe Photoshop 6.0. For detailed instructions, see the Help menu of the
application.

• This feature is only supported by Windows 98 and Windows 2000. It is
not supported by Windows Me and Windows XP.

• To load images with Adobe Photoshop, the TWAIN Driver and this
program must be correctly installed onto the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Loading Images into Adobe Photoshop
Starting the TWAIN Driver from within Adobe Photoshop
USB Connection

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
Digital Terminal. Prepare the camera for communication with the computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The Event dialog will display and allow you to select an application program to

start.

2. Select [Photoshop] and click [OK].

• Adobe Photoshop and the TWAIN driver will start (p. 51).

If the TWAIN driver does not start automatically, select [Import] from the
[File] menu and then [Canon PowerShot A200 USB].

CF Card Reader/PC Card Reader Connection

1. Insert the CF card or loaded PC card adapter into the reader.

2. Click the Windows [Start] menu and select [Programs], [Adobe] and
[Photoshop].

• Adobe Photoshop will start.

3. From the [File] menu, select [Import] and then [Canon PowerShot A200
USB].

• The TWAIN driver will start (p. 51).
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Rotate 90
Degrees
Buttons
Click a button to
rotate the selected
image 90 degrees
left or right.

Preferences Button
Click here to adjust or
check image
transmission settings.

Camera Settings Button
Click here to adjust or check camera settings (p. 36).

Image
Selection
Button

Protection
On/Off
Button

Check Mark On/Off Button
You can choose an image
selection method if you press
the [Select] button after
adding a check mark.

Play Memo
Button
Click here to play
a voice memo
associated with
an image.

Help
Button

Main Buttons
Click these buttons to
perform the main
tasks, such as loading
images and closing
the TWAIN Driver.

Image Data
Display Area

Display Area for
Image Folder
Selection

Image Display Area
Images display here
when a camera is
connected.

Comment Box
Input a comment of up to 120 characters
here. (You cannot input a comment
while the camera is connected.)

• TWAIN Driver Window

Image Transmission
Mode List Box
Click here to select to
transmit the selected
images as a single image
or as an index sheet.

Display Mode
List Box
Click here to select
between the
Thumbnail and
Preview display
modes.

Display Size
List Box
Click here to
select an image
display size.

Image Format
List Box
Click here to select
the format of the
images you wish to
display.
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Loading Images with the TWAIN Driver

• The TWAIN Driver only displays still images. To download movies, use
ZoomBrowser EX (p. 32).

Loading from the Camera

1. Click the [Camera Connection] button.

• The camera’s images will display in the Thumbnail Display Area.

2. Select the image(s) you wish to load and click the [Transfer Image] button.

• The image(s) will appear in Adobe Photoshop.

3. Click the [OK] button.

• The aquired image(s) will display in Adobe Photoshop’s main window. To save
the aquired image(s), click the [File] menu of the image editing software and
select [Save as]. Input a file name and change the file location and format
settings if necessary.

Loading from a Card Reader

1. Click the [Open Folder] button.

• The Image Folder Selection dialog or the My Computer dialog will display.

2. Select the folder containing the images and click [OK].

• The CF card images will display in the Thumbnail Display Area.
• Please see page 16 for a description of the CF card file structure.

3. Select the image(s) you wish to load and click the [Transfer Image] button.

• The image(s) will appear in Adobe Photoshop.

4. Click the [OK] button.

• The acquired image(s) will display in Adobe Photoshop’s main window. To save
the acquired image(s), click the [File] menu of the image editing software and
select [Save as]. Input a file name and change the file location and format
settings if necessary.
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Downloading Images with the WIA Driver

If you are using Windows Me or Windows XP (and installed the WIA Driver), you have
the following alternatives for downloading images to the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Downloading with the Scanners and Cameras Wizard
Follow the Wizard’s step-by-step instructions to download images to the computer.

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The Scanners and Cameras Wizard will open automatically.

2. Click the [Next] button.

3. Select the image(s) you wish to download and click the [Next] button.

• To select multiple images, press and hold the [Ctrl] or [Shift] key on the
keyboard while clicking on images. To select all the images, click [Select All].

4. Specify a filename and save location and click the [Finish] button.

• The selected images will download to the specified folder. If you do not specify
a folder, they are saved by default to the [My Pictures] folder within the
computer’s [My Computer] folder.
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4. Copy images to a folder on the hard disk using standard Explorer file
copying procedures.

• Copy by Specifying a Folder
Select an image in the Explorer window, right-click the mouse, select [Save] and
specify a folder. The image and its thumbnail will be downloaded to the
specified location.

• Copy by Dragging and Dropping
Select an image in the Explorer window, drag it to the target folder and drop it.
This will download the image and its thumbnail.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Downloading with Windows Explorer
Images can be downloaded to the computer with Windows Explorer just as you
would copy any other file.

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The Scanners and Cameras Wizard will open automatically.

2. Click the [Cancel] button.

3. Start Windows Explorer and select your camera’s icon in it.

• The camera’s images will display as thumbnails in the Explorer window.
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Downloading with the File Dialog
You can select an image with the Open dialog, load it into the program and save it to
the computer. This topic explains how to load images using Adobe Photoshop 6.0.

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The Scanners and Cameras Wizard will open automatically.

2. Click the [Cancel] button.

3. Start Adobe Photoshop.

4. Select [Open] from Adobe Photoshop's [File] menu.

• The Open dialog will display.

5. Select your camera’s icon in
the file list.

• The camera images will display.

6. Select the image(s) you wish to download and click the [Open] button.

• The selected image(s) will load into the program.
• To save the loaded image(s), click the [File] menu and select [Save As]. Input a

file name and change the file location and format settings if necessary.

Loading Images with Windows TWAIN Source
You can also load images, into a program with Windows TWAIN Source.
1. Connect the camera to the computer with the USB interface.
2. Start a TWAIN-compliant program, such as Adobe Photoshop.
3. Open the dialog in which you can select the TWAIN source and select [WIA-your

camera model], where your camera model name appears after “WIA”.
4. Start TWAIN Source.
5. Select the image(s) you wish to download and click the [Acquire] button.

The selected image(s) will load into the program.
The procedures for starting TWAIN-compliant programs and opening their dialogs
may vary between programs. Refer to the program manuals for more details.
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Installing/Uninstalling the Software
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Installing from the Canon Digital Camera Solution Disk

Mac OS 8.6-9.2

1. Close any programs that are running.

2. Set the Canon Digital Camera Solution Disk in the computer’s CD-ROM drive.

3. Double-click the CD-ROM icon, followed by the [Mac OS 8/9] and [Canon
Digital Camera Installer] icons.

• The installer panel will display.

4. Click [Digital Camera Software Installation].

5. Follow the onscreen instructions to proceed with the installation.

6. After the installation is complete, restart the computer as prompted.

Mac OS X

1. Close any programs that are running.

2. Set the Canon Digital Camera Solution Disk in the computer’s CD-ROM
drive.

3. Double-click the CD-ROM icon, followed by the [Mac OS X] and [Canon
Digital Camera Installer] icons.

• The installer panel will display.

Installer Panel
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5. Follow the onscreen instructions to complete the installation.

4. Click [Digital Camera Software Installation].

Installer Panel
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Installing the Card Photo Printer CP-10 Printer Driver
The driver for Card Photo Printer CP-10 (sold separately) must be installed to print
from a CP-10 connected to the computer.* For installation instructions, please see
the Card Photo Printer CP-10 Printer Driver User Guide contained on the Canon
Digital Camera Solution Disk as a PDF file.

* Interface Cable PIF-100 (sold separately) is required to connect the Card Photo Printer
CP-10 to a computer.
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Uninstalling the Software

Uninstalling Application Programs
Move the program’s folder into the Trash to uninstall programs such as
ImageBrowser, PhotoStitch, RemoteCapture and USB Mounter.

• If the program folders contain subfolders into which images have been
saved, be careful not to accidentally delete those subfolders.

Uninstalling the Plug-In Module
For instructions to uninstall the Plug-In Module, please open the [Canon Utilities] and
[Camera Plug-In] folders and read the [ReadMe] file.

Uninstalling the Card Photo Printer CP-10 Printer Driver
For instructions to delete the printer driver, please see the Card Photo Printer CP-10
Printer Driver User Guide contained on the Canon Digital Camera Solution Disk as a
PDF file (p. 5).
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Downloading Images to a Computer

This topic briefly explains how to use ImageBrowser to perform a range of operations
from downloading the camera’s images to printing them.

• For a more detailed explanation, please see the ImageBrowser Help menu
or PDF manual, ImageBrowser Software User Guide (p. 4).

If the Continue Connection Confirmation Message Displays
• A message asking whether you wish to remain connected may appear when the

[Auto Power Down] function is set to [On], the camera and computer are
connected via the USB interface, and the connection is idle for a set period of
time (usually about 5 minutes). If the connection remains idle, the camera will
disconnect after approximately 1 minute.

Press the camera’s  button to reconnect. Please see the Camera User Guide for
more information.
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Starting ImageBrowser

USB Port Connection (Mac OS 8.6-9.2)

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
Digital Terminal. Prepare the camera for communication with the computer.

• For USB interface connection instructions, see “Connecting to a USB Port” (p. 14).
• ImageBrowser will start and open the ImageBrowser Automation Wizard

dialog.

2. Confirm that [Display Images] is selected and click the [OK] button.

Confirm that this
option is selected.

The Communications Settings dialog will display. This dialog only appears
the first time the camera is connected.
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3. Confirm that [USB port] and your camera model name are selected and
click the [Set] button.

• For more detailed instructions for changing settings, please see
the PDF manual, ImageBrowser Software User Guide (p. 4).

To change the settings, click [Settings
Change] and select the desired action
in the ImageBrowser Automation
Wizard dialog.

Your camera model name
will appear here.

• The Camera Window will open and display the camera images as thumbnails
(tiny versions) (p. 65).

• In the ImageBrowser Automation Wizard dialog, you can select the
action that is carried out after ImageBrowser starts. For more details,
see the PDF manual, ImageBrowser Software User Guide (p. 4).

What to Do the Next Time ImageBrowser is Started
• A dialog with the previously selected automated settings will display the next

time you start ImageBrowser. To use these settings unchanged, click the [Start]
button. To do nothing, click [Cancel]. To change the settings, click [Settings
Change].
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How to Set ImageBrowser to Not Start Automatically
1. Click the Apple menu  and select [Control Panels] and [Canon ImageBrowser

Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the check mark.
3. Click the close box  at the upper left to close the dialog.

ImageBrowser will cease to start automatically thereafter.

Click here to close the dialog.

Clear the check mark here to stop
ImageBrowser from starting
automatically.

USB Port Connection (Mac OS X)

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s DIGITAL Terminal. Prepare the camera for communication with
the computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).

2. Double-click the [Canon ImageBrowser] icon on the desktop.

• If the Canon ImageBrowser icon does not appear on the desktop, double-click
the [Canon Utilities] folder on the drive on which the program was installed,
followed by the [ImageBrowser] folder and [ImageBrowser] icon.

3. Click [Canon Camera] in the Explorer View section.

• The Communications Settings dialog will display.
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4. Confirm that [USB Port] and your camera model name are selected and
click the [set] button.

This dialog will only appear for the first connection.
The Camera window will open and display the camera images as
thumbnails (tiny versions) (p. 65).

CF Card Reader/PC Card Reader Connection

1. Insert the CF card or loaded PC card adapter into the reader.

2. Start ImageBrowser.

• Double-click the [Canon ImageBrowser] icon on the desktop.

Your camera model name and the
USB port number (i.e. @1) will
display here.
For example, “PowerShot A200@1”

• If the icon does not appear on the desktop, double-click the folder in which you
installed the program, followed by the [Canon Utilities] and [ImageBrowser]
folders and the [ImageBrowser] file.

3. Double-click the [DCIM] folder in the Explorer View Section.

• The images from the CF card will display as thumbnails in the Camera window
(p. 65).

Mac OS 8.6 - 9.2 Mac OS X

Mac OS 8.6 - 9.2 Mac OS X

Explorer View
Section



65

M
ac

in
to

sh

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

The ImageBrowser Camera Window
When a connection is opened to a CF card in a camera or a reader, the card’s images
display as thumbnails in the Camera window.

Upload Button
Copy images from the computer onto
the CF card in the camera or reader.

An image of the connected camera or
CF card will display here.

Thumbnail

Setup Options Button
Set various camera
settings (see inset
below).

Delete Button
Delete selected
images.

Download Button
Load the selected images onto the computer (p. 66).

Your camera model name will appear here.

Input a camera owner name here (up to 31
characters).

Set the date and time here.

Click this button to synchronize the camera to
the computer’s date and time settings.

Check the battery charge here.

Click this to format the CF card in the camera.

Check the remaining memory capacity here.

How to Check and Change Various Camera Settings
You can adjust the date, time and owner settings in the Camera Settings dialog using
the computer when the camera is connected. You can also check the battery charge
and remaining memory capacity.

1. Click the [Setup Options] button and select [Camera Settings] from the displayed
menu. In the Plug-In Module, click the [Camera Settings] button to open the
Camera Settings dialog (p. 80).

2. Check or change the settings.
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2. Create a new folder for saving images from the camera.

• Click the [File] menu and select [New Folder]. A folder with the name
“Untitled” will be created. Click it to change the folder name as you wish.

3. In the Explorer View Section, click the newly created folder.
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Downloading and Saving Images from the Camera

1. With Mac OS 8.6-9.2, select [Macintosh HD] in the Explorer View Section.
With Mac OS X, select the [your name] subfolder of the [Users] folder in
the startup disk.

Mac OS 8.6 - 9.2 Mac OS X

Explorer View
Section

Mac OS 8.6 - 9.2 Mac OS X
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The movie icon displays
on movie thumbnails.

Thumbnail

Downloaded images are saved to the computer and appear in the Browser
area.

• You can also download images to the computer by dragging them from the
Camera window and dropping them on the Browser area or the Explorer View
Section.

4. Select images in the Camera window and click the [Download] button.

• Click a thumbnail to select it or press [Shift] and click to select multiple
thumbnails.

To disconnect the camera, click the close box  (Mac OS 8.6-9.2) or the red close box

 (Mac OS X) at the upper left of the Camera window. The Camera window will
close.

Browser area

The movie icon
displays on movie
thumbnails.

Explorer View Section
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Printing Images

1. Select the image(s) you wish to print.

• Movie images cannot be printed.

2. Click the [Print] button and select [Layout Printing] from the displayed
menu.

3. In the Layout Options window, select the desired layout and click the
[Next] button.

• Select the [Custom layout printing] option for the purposes of this example.

• The Custom Layout printing option in the Layout Options window allows
you to freely change the size and position of the images for printing. The
other options allow you to print an index or print onto Canon perforated
paper. For more details on the Layout Options window, please see the PDF
manual, ImageBrowser Software User Guide (p. 4).

• The [Canon perforated paper printing] option can not be selected with Mac OS X.

Layout Options Window

Print Window
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4. In the next window, select a paper size and click the [OK] button.

• The Layout Options window will close and the Print window will open, allowing
you to change the layout and printing settings.

• The settings available in Step 4 will vary according to the type of layout
selected in Step 3.

5. Adjust the page layout in the Print window if you wish.

6. Click the [Print] button in the Print window.

• The Print dialog will display.

7. Click [OK] to start printing.

• Print Window
When the Custom layout printing option is selected in the Layout Options window,
you can freely change the size and position of the images for printing.

Add Text
Open the [Edit] menu and
select [Add Text].

Add Captions to Images
Click the image and then
the [Edit] menu and select
[Edit Caption].

Displays the Layout Options
window.

Display the Print dialog.

Change the default
number of images
printed per page.

Rotate the selected
image.

Reset the layout.

Change the
Image Size
Drag the border
to resize the
image.

Edit the Page Title
Open the [Edit] menu and
select [Edit Header].

Change the Layout
Drag the images to
change the layout.
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Replaying Movies
When you double-click an image with a movie icon in the Browser Window,
QuickTime Player will start and replay the movie.

• Users of Mac OS 8.6-9.2 that have not already installed QuickTime 3.0
or a later version can install QuickTime 5.0 from the Canon Digital
Camera Solution Disk. Place the disk in the CD-ROM drive and click
[QuickTime 5.0 Installation] in the installer panel (p. 58).

1. Double-click an image with a movie icon.

• QuickTime Player will start.

2. Click the play button in QuickTime Player.

• The movie will replay.

Play Button

ImageBrowser Features

This topic introduces additional, convenient ImageBrowser features.

• For a more detailed explanation, please see the ImageBrowser Help
menu or PDF manual, ImageBrowser Software User Guide (p. 4).
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Mac OS 8.6 - 9.2
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Merging Panoramic Images with PhotoStitch

To Merge Images Registered in ImageBrowser

You can merge a series of overlapping images into a single, seamless panorama.

1. Select the images in the Browser Window, click the [Edit] menu and select
[PhotoStitch] to start the program.

2. Follow the instructions in the guidance window to merge the images.

• Please refer to the PhotoStitch Help menu for more details.
• Images shot in Stitch Assist mode with a wide converter, teleconverter or close-

up lens cannot be merged accurately.

Follow the instructions
to merge the images.

Mac OS X

Images Shot in Stitch Assist Mode
PhotoStitch automatically arranges images shot with the camera’s Stitch Assist mode
in their correct order and orientation, making it easy to merge them. Stitch Assist
mode images appear in the Camera window as shown below.

Please see the Camera User Guide to learn how to shoot in Stitch Assist mode.

Stitch Assist mode images have a green
stitch mark. Click the stitch mark to start
PhotoStitch and merge the image series.
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• Save-RemoteCapture Window

View Button
Select an image in the Thumbnail View and click
here to display it in the Image Display Area.

Delete Button
Select an image in the Thumbnail View and click here
to delete it. Since it is deleted from the computer too,
ensure that you have the correct image.

Histogram
Check the distribution of brightness data here.

Image Information
Check the image settings here.

Comments
Add a comment about the image here.

Thumbnail View
Displays thumbnails of all the images
shot after RemoteCapture is started.

Connect/Disconnect Button
Click here to open a connection to the camera and
display the RemoteCapture Shooting window. It will
change to the Disconnect button while a connection
is open. Click it to close the connection.

Image Display Area
Displays the image selected in the Thumbnail View.
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Shooting with RemoteCapture
(Compatible with Mac OS 8.6-9.2 only)

RemoteCapture will start if you click the [Edit] menu in ImageBrowser and select
[RemoteCapture] when the camera is connected to the computer via a USB interface
(If the camera window appears when you connect the camera to the computer, close
the window). RemoteCapture lets you control the camera’s shutter remotely from the
computer to shoot still images.

• You can also save images directly to the computer by pressing the
camera’s shutter button. Other buttons and switches on the camera,
including the zoom, will not operate with a transmission in progress.

• You may notice that the interval between the shutter release and activation is
slightly longer when RemoteCapture is used to shoot than when the camera
is used in the normal fashion.

•  Images shot with RemoteCapture are automatically saved to the folder
selected in ImageBrowser.

• You cannot use RemoteCapture when the USB Mounter is running (p. 81).
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• Shooting-RemoteCapture Window

Slide this to zoom the
camera in or out.

Set the basic camera settings here.

Release Button
Click here to release the camera’s
shutter and record the image.
Recorded images are automatically
saved to the computer.

Recordable Image Counter
Displays the number of images
that will fit onto the computer or
memory card in the camera.

Select how images are
rotated when saved to
the computer.

Click here to change more detailed
camera settings.

Test Preview
A Preview of the test shot displays.

Test Shot Button
Takes a test shot.Test
shots are not saved to
the computer.
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Shooting

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
Digital Terminal. Prepare the camera for communication with the computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• Open the lens cover after the connection is established.
• ImageBrowser will start and open the Auto Run Settings dialog.

2. Click the [Settings Change] button.

3. Select [Launch RemoteCapture] and click the [OK] button.

• RemoteCapture will start and display the “Connect to Camera?” dialog.

• If ImageBrowser is already running, click the [Edit] menu and select
[RemoteCapture] to start RemoteCapture.

4. Click [Connect].

• Shooting-RemoteCapture window will display.

5. Set the Size/Quality, Flash, White Balance and Exposure Compensation
settings.

• If you turn the camera on either side to shoot, you can rotate the recorded
image 90º either way when it is saved by selecting [90 degrees left] or [90
degrees right] in the Rotation Settings section. To change where the image is
saved, see Changing the Save Location and Other Preferences (p. 76).

6. If you click the [Test Shot] button, you can check the image composition in
the Test Preview Area of the Shooting-RemoteCapture window.

• You can change the focal length with the Zoom slider.
• Click the [Detail setting] button to change more detailed camera settings.

7. Click the [Release] button.

• The image will record and be automatically saved to the computer. You can also
release the shutter by pressing the camera’s shutter button directly or by
pressing the space bar on the computer keyboard.
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Interval Timer Shooting

You can shoot a specified number of frames at set intervals.

1. In the Save-RemoteCapture window or Shooting-RemoteCapture
window, click the [File] menu and select [Interval Timer Shooting].

• The Interval Timer Shooting dialog will display.

2. Set the number of frames and the interval value and click [OK].

• RemoteCapture will start Interval shooting, capturing the specified number of frames
at the specified interval. You can specify an interval from 5 seconds to 60
minutes. You can capture up to the number of recordable frames displayed in the
Shooting-RemoteCapture window (2 to 9999 frames).

Timer Shooting

You can use the timer feature to shoot after a specified number of seconds.

1. In the Save-RemoteCapture window or Shooting-RemoteCapture
window, click the [File] menu and select [Timer Shooting].

• The Timer Shooting dialog will display.

2. Set the delay in seconds and click [OK].

• RemoteCapture will start timer shooting, recording an image after the specified
delay. You can specify a delay from 2 to 30 seconds.

Precautions when Shooting with RemoteCapture
• If your computer is set to go into standby mode, there is no guarantee that

RemoteCapture will continue to function after the computer enters standby
mode. Always turn off the standby function before you start shooting with
RemoteCapture.

• Please note that the camera will not be able to shoot at the specified interval if it is
shorter than the time required to transmit the data and save it on the computer.



76

Changing the Save Location and Other Preferences

You can change where and how image files are saved.

1. In the Save-RemoteCapture window or Shooting-RemoteCapture
window, click the [File] menu and select [Preferences].

The Preferences dialog will display.

2. Select the way images are saved and the folder to which they are saved
and click [OK].

• Preferences Dialog

Printing an Index of the Thumbnail Images
If you select images in the Thumbnail View area of Save-RemoteCapture window,
you can print them in an index like a contact sheet.

1. Select the images, click the [File] menu and select [Print Index].
The file name and shooting date are printed along with each image in the index,
providing a convenient record and means of checking your images.

Click an option to determine
whether images are saved to the
camera’s CF card as well as the
computer. If you select [Computer
only], you can do without a CF card
in the camera or continue to record
images after the CF card is full.

Input a root name here. If you input
“Capture”, for example, the first
image will be named
[Capture_00001.jpg] and successive
images will automatically be
assigned a name one digit higher
than the last.

Images are automatically given a file
name with a sequence number
starting with the number you input
in [Start].

Select a folder for saving images.
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Loading Images into Plug-In Compliant Programs
(Compatible with Mac OS 8.6 -9.2 only)

This topic explains how to load images into Adobe Photoshop 6.0.
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Loading Images into Adobe Photoshop

• To load images into Adobe Photoshop, the Plug-in Module and Adobe
Photoshop must be correctly installed onto the computer.

Copy the Plug-In Module into the Adobe Photoshop
[Plug-Ins] Folder

1. Double-click the folder in which you installed the program, followed by
the [Canon Utilities] and [Camera Plug-In] folders to open them.

2. Copy the [Canon Camera Plug-In 4] file to the Adobe Photoshop [Import/
Export] folder.

Starting Adobe Photoshop
USB Connection

1. Attach the supplied USB cable to the computer’s USB port and the camera’s
Digital Terminal. Prepare the camera for communication with the computer.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• ImageBrowser will start and open the ImageBrowser Automation Wizard dialog.

2. Click the [Cancel] button.

• ImageBrowser will appear, but since you do not need it, click the [File] menu
and select [Quit] to close it.

• Please see page 63 for instructions for stopping ImageBrowser from starting
automatically.

3. Start Adobe Photoshop.
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Click here to clear the check mark.

Click here to close the dialog.

If the “ImageBrowser Not Found” Dialog Appears
This dialog may display if you install the Plug-In Module without installing
ImageBrowser, and then connect via the USB interface. Use the following procedures
to change the auto start setting for ImageBrowser.

1. Click [OK] on the ImageBrowser Not Found dialog.
2. In the Settings for USB Connection dialog, click the [The application program

below will start.] option to clear the check mark.
3. Close the Settings for USB Connection dialog.

This will prevent the ImageBrowser Not Found dialog from appearing the next time
the camera is connected.

• You can also open the Settings for USB Connection dialog by clicking the Apple
menu  and selecting [Control Panels] and [Canon ImageBrowser Auto Launch].

CF Card Reader /PC Card Reader Connection

1. Insert the CF card or loaded PC card adapter into the reader.

2. Start Adobe Photoshop.
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Starting the Plug-In Module and Downloading Images

• The Plug-In Module can only display still images. Start ImageBrowser to
download movies to the computer.

Downloading from the Camera

1. Click the Adobe Photoshop [File] menu and select [Import] and [Canon
Camera Plug-In 4].

2. Click the  icon, confirm that [USB Port] and your camera model name
are selected and click the [Set] button.

3. Click the [Camera Connection] button.

• The camera’s images will display in the Image Display Area.

4. Select the image(s) you wish to download and click the [Transfer Image]
button.

• The downloaded image(s) will appear in the Adobe Photoshop window.

5. Click the [Exit] button to close the Plug-In Module.

• To save the loaded images, click the Adobe Photoshop [File] menu and select
[Save As]. Input a file name and change the file location and format settings if
necessary.

Downloading from a Card Reader

1. Click the Adobe Photoshop [File] menu and select [Import] and [Canon
Camera Plug-In 4].

2. Click the [Open Folder] button.

3. Select the folder containing the images and click [OK].

• The images on the CF card will appear as thumbnails in the Thumbnail Display
Area.

• Please see page 16 for a description of the CF card file structure.

4. Select the image(s) you wish to load and click the [Transfer Image] button.

• The image(s) will display in the Adobe Photoshop window.

5. Click the [Exit] button to close the Plug-in Module.

• To save the loaded image(s), click the Adobe Photoshop [File] menu and select
[Save As]. Input a file name and change the file location and format settings if
necessary.
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Image Transmission Mode
List Box
Click here to select to transmit
the selected images as single
images or as an index sheet.

Display Mode List Box
Click here to select
between the Thumbnail
and Preview display
modes.

Display Size
List Box
Click here to
select an image
display size.

Image Format
List Box
Click here to select
the format of the
images you wish to
display.

Rotate 90
Degrees Buttons
Click a button to
rotate the selected
image 90 degrees
left or right.

Preferences Button
Click here to adjust or check image transmission
settings.

Camera Settings Button
Click here to adjust or check camera settings (p. 65).

Image Selection
Button

Protection
On/Off Button

Check Mark On/Off Button
You can choose an image selection method
if you press the [Select] button after adding
a check mark.

Play Memo Button
Click here to play a voice memo
associated with an image.

Main Buttons
Click these
buttons to
perform the main
tasks, such as
loading images
and closing the
Plug-In Module.

Image Data
Display Area

Display Area for
Image Folder
Selection

Image Display Area
Images display here
when a camera is
connected.

Comment Box
Input a comment of up to 120 characters here.
(You cannot input a comment while the
camera is connected.)

Communication Settings Button
Click here to adjust communication settings between the camera and the computer.

• The Plug-In Module Window



81

M
ac

in
to

sh

Downloading Images with the USB Mounter
(Compatible with Mac OS 9.0-9.2 only)

The USB Mounter is a driver that allows images on a CF card in a camera to be
displayed on the computer screen as if the camera were a drive or a connected card
reader. Images can be downloaded to the computer with the same procedures used
to copy images from a card reader.

• To enable the USB Mounter, the camera must be handled as if it were a
drive like a card reader. Consequently, the following cannot be
performed while the USB Mounter is running.
- ImageBrowser cannot be automatically started when the USB

connection is opened.
- You cannot open a connection to ImageBrowser or the Plug-In

Module and adjust camera settings.
- You cannot shoot with RemoteCapture.
- In addition, images cannot be deleted from the camera and the

computer images cannot be uploaded to the camera.
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Enabling the USB Mounter
To download images with the USB Mounter, first enable it with the following procedures.

1. Select [Control Panels] from the Apple menu  and [Canon USB Camera
Driver].

• The Canon USB Camera Driver control panel will display.

2. Select [Card Reader Mode] and
close the control panel.

• A dialog prompting you to restart
the computer will display.

3. Click [Yes] to restart the computer.

• The USB Mounter will be enabled.

How to Disable the USB Mounter
Disable the USB Mounter when you need to upload images to the camera or shoot
with RemoteCapture.

1. Select [Control Panels] from the Apple menu  and [Canon USB Camera Driver].
The Canon USB Camera Driver control panel will display.

2. Select [Camera Mode] and close the control panel.
After you restart the computer, the USB Mounter will be disabled.

Click here to close it.
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3. Select the folder containing the images.

• The images on the CF card will display as file icons.
• Please see page 16 for a description of the CF card file structure.

4. Copy images to the computer’s hard disk using standard file copying
procedures.

• Select images and drag and drop them onto the target folder on the computer
to download them.

• Never turn off the power or detach the USB cable while copying. The
equipment may not operate correctly.

How to Download Images from ImageBrowser and the Plug-In
Module while the USB Mounter is Enabled

When the USB Mounter is enabled, use the card reader downloading procedures in
ImageBrowser or the Plug-In Module to download from the camera. See CF Card
Reader / PC Card Reader Connection (p. 64) for ImageBrowser and Downloading from
a Card Reader (p. 79) for the Plug-In Module.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Downloading Images

1. Attach the supplied USB cable to the computer’s USB port and the
camera’s Digital Terminal.

• For USB interface connection instructions, see Connecting to a USB Port (p. 14).
• The camera icon will display on the desktop.

2. Double-click the camera icon.

Camera Icon
Your camera model name will appear here.



This topic explains some of the causes for and solutions to
problems with the software.

Troubleshooting
(Windows / Macintosh)
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Can’t download images, camera is not recognized or the Event
dialog does not display when the camera is connected via the USB
interface.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #1
Computer doesn’t support the USB interface.

The USB interface is not supported for computers not in compliance with the
following requirements. Acquire the necessary system to use the USB interface.
Requirements
• Built-in USB interface on a system preinstalled with one of Windows 98  (First or

Second Edition)/Windows Me / Windows 2000 /Windows XP. (With Windows XP,
the Event dialog does not display)

• Genuine Apple Computer brand computer with a built-in USB interface.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #2
Camera is not correctly connected to the computer.

Read Connecting the Camera to a Computer (p. 13) and check the connection.
Ensure that you are using the correct cable and that its connectors are in good shape.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #3
The camera is not set to replay mode.

Refer to the table below and set your camera to replay mode.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #4
Insufficient battery charge.

If you are powering the camera with batteries, ensure that the charge is sufficient.
You should power the camera with a household power source while it is connected
to the computer.

PowerShot A200 Press the      button.
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○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #5
The Communications Settings are incorrect.

If the following screen appeared when you connected the camera with the USB cable,
the Communications Settings are incorrect. In the [Port Type] section, select [USB], and
in the [Detected Camera Models] section, select the name of your camera model.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #6
The camera is being recognized as an “Other device”. (Windows only)

Use the procedures below to check whether or not your camera is being recognized
as an “Other device”. If it is being recognized as an “Other device”, delete its driver
and setup information files and reinstall the driver.

Windows 98/Windows Me
Checking whether the camera is being recognized as an
“Other device”, and deleting the driver.

1. In the [Control Panel], double-click the [System] icon.
The [System Properties] dialog appears.

2. Click the [Device Manager] tab.

3. Click the  of [Other devices] and/or [Imaging Devices].
If your camera is being recognized as an “Other device”, its model name
will appear.

• If your camera model name does not appear, or if [Other devices] and/or
[Imaging Devices] do not appear, the cause lies elsewhere. Proceed to step 6
to end this operation and refer to the other causes. (pp. 84 - 88)

4. Select the name of your camera model and click [Remove].

5. In the confirmation dialog, click [OK].
Remove all copies of your camera model name that appear in the [Other
devices] or [Imaging Device] categories, or that appear more than once in
one category.

6. Click [OK] to close the [System Properties] dialog.
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Reinstalling the Driver

11. Refer to Installing the TWAIN Driver/WIA Driver and reinstall the driver. (p. 21)

• The Inf folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you
delete the wrong file, you may be unable to restart Windows.

Windows 2000/Windows XP
• Users of Windows 2000 or Windows XP Professional must first log in as an

Administrator (computer system administrator) to uninstall the driver.

Checking whether the camera is being recognized as an
“Other device”, and deleting the driver.

1. Windows 2000: In the [Control Panel], double-click the [System] icon.
Windows XP: In the [Control Panel], click [Performance and Maintenance]
and click [System].

2. Click the [Hardware] tab and the [Device Manager…] button.

Deleting the Setup Information

7. Double-click the [My Computer] icon on the desktop followed by the [C:\]
drive and the [Windows] and [Inf] folders.

If the [Inf] Folder is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
3. Windows 98: Set the [Hide files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show hidden files
and folders].

4. Click [OK] to close the dialog.
This will make the hidden files and folders visible.

8. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

9. In the [Inf] folder, double-click the [Other] folder to open it.

10. Find and delete the [Canon.IncCAP_A200] file.
If the above file is not contained in the Other folder, you do not need to
delete anything.
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3. Click the  of [Other devices] or [Imaging Device].
If your camera is being recognized as an “Other device”, its model name
will appear.

• If your camera model name does not appear, or if [Other devices] and/or
[Imaging Devices] do not appear, the cause lies elsewhere. Proceed to step 6
to end this operation and refer to the other causes. (pp. 84 - 88)

4. Select the name of your camera model, right-click the mouse button and
select [Delete].

5. In the confirmation dialog click [OK].
Remove all copies of your camera model name that appear in the [Other
devices] or [Imaging Device] categories, or that appear more than once in
one category.

6. Click [OK] to close the [System Properties] dialog.

Deleting the Setup Information

7. Windows 2000: Double-click the [My Computer] icon on the desktop,
followed by the [C:\] drive, and the [Winnt] and [Inf] folders.
Windows XP: From the [start] menu, click [My Computer], [C:\], [Windows]
folder, and [Inf] folder in succession.

If the [Inf] Folder is Not Visible in the [Winnt] or [Windows] Folder
Use the following procedures to show all files and folders.

1. Windows 2000/Windows XP: Open the [Winnt] or [Windows] folder.
2. Windows 2000/Windows XP: Click the [Tools] menu and select [Folder

Options].
3. Click the [View] tab.
4. Windows 2000/Windows XP: In the [Advanced settings] section, set the

[Hidden files and folders] category to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check mark.

5. Click [OK] to close the dialog.
This will make the hidden files and folders visible.
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8. Look for the file starting with [Oem*].
• A number such as “0” or “1” will appear in place of the asterisk (*) above. You

will also find another file called [Oem*.pnf], which will have the same number
as the [Oem*.inf] file. The two constitute one set (i.e. Oem0.inf and Oem0.pnf).
Please note that there may be many files sets starting with “Oem” so take care
to get the correct set.
Confirm that it is the correct [Oem*] file set for Canon digital cameras.
When you double-click the [Oem*.inf] file, the Windows Notepad program will
start and show the file contents. Click each [Oem*.inf] file until you find one
that contains”***Canon Digital Camera USB Setup File***” in its first line.
When you find the correct file, note down its name and close the Notepad
window.

9. Delete the [Oem*] file set.
Delete the [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the
correct files.

Reinstalling the Driver

10. Refer to Installing the TWAIN Driver/WIA Driver and reinstall the driver. (p. 21)

• The Inf folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you
delete the wrong file, you may be unable to restart Windows.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #7
The USB driver is not installed correctly. (Windows only)

Uninstall the driver and reinstall it.
For more details on how to uninstall the USB driver, refer to Uninstalling the TWAIN
Driver/WIA Driver (p. 27).
For more details on how to install the USB driver, refer to Installing the TWAIN Driver/
WIA Driver (p. 21).

ZoomBrowser EX displays a database file related error message
(E_Fail error, etc.) (Windows only)

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Cause #1
ZoomBrowser EX database file may be corrupted.

Please restore the database using the procedures described in the Troubleshooting
section of the PDF manual, ZoomBrowser EX Software User Guide. You can display
the ZoomBrowser EX Software User Guide from the installer panel of the Canon
Digital Camera Solution Disk.
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If an error message appears the first time you start ZoomBrowser EX

If the error message “The error “EX_Exception” occurred in the
program” appears, please follow the below instructions to solve the
problem.

1. Click [OK] to close the dialog window.

2. When the message “ZoomBrowser EX will now exit, without adding your
“My Pictures” folder.” appears, click [OK] and close ZoomBrowser EX.

3. Click the button of the drive on which your OS is installed; usually the [C:]
drive (when your click on the button, it will change to as shown in the
screen below). Create a [My Pictures]* folder in the [My Documents] folder.

The underlined instructions above differ according to the computer’s OS.

Windows 98/Windows 98SE
From the [Start] menu, select [Programs] and [Windows Explorer]. The [C:] drive
will display.

Windows Me
From the [Start] menu, select [Programs], [Accessories] and [Windows Explorer].
Click the  button of [My Computer]. The [C:] drive will display.

Windows 2000/Windows XP
From the [start] menu, select [All Programs], [Accessories] and [Windows
Explorer]. Click on the  button of the [My Computer] folder and the [C:] drive.
Click in succession the [Documents and Settings] folder, [User name] folder, [My
Documents] folder and create a [My Pictures]* folder.

*When you create the [My Pictures] folder, be sure to input the characters
exactly the same way as shown in the below screen. (Capital letters for
capital letters, lowercase letters for lowercase letters, insert a space
between “My” and “Pictures”)

4.  Restart your computer and start ZoomBrowser EX.

Windows 98 screen shot shown.
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Canon Customer Support

For Canon Customer Support contacts, please see the Canon Limited Warranty
supplied with your camera.




